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CLC Genomics Workbench  
ハンズオントレーニング 

変異解析編 

株式会社キアゲン 
グローバルイフォマティクス ソリューション＆サポート 

アプライドアドバンストゲノミクス 
 



Sample to Insight 

Genomics Workbench で可能な解析 

マッピング 

Quality check 

インポート 

ピーク精査 

ピーク検出 アノテーション付け 

タグの抽出 

インポート 

miRBase  
ダウンロード 

既知のmiRNAと 
それ以外の分類    

RNA-seq 

Quality check 

インポート 

群間比較 

RPKM計算 

De Novo  
アッセンブリ 

Quality check 

インポート 

BLAST検索 

新規生物種 ChIP-seq RNA-seq small RNA 

マッピング 

Quality check 

インポート 

変異検出 

変異解析 

フィルタリング 
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Sample to Insight 

データ管理 
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データロケーション • Genomics Workbench ではデータ保存の階層の
トップをLocationと呼びます。 

• デフォルトのLocationはCLC_Dataが作成されて
いますが、左の図のようにLocationは追加可能
です。 

 

• Location の新規追加は、Navigation Area 左上の
アイコンから作成可能です。シークエンスデー
タはサイズが大きいため、容量が大きいディス
クへLocationを作成することをお勧めします。 

 

 

 

 

• また解析が一通り終了し、バックアップや外付
けのディスクへ移動する場合は、このLocation
単位での移動をお願いします。 

Location 

Folder 

Location 作成 

Folder 作成 
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今日のデータ 
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データインポート 

今日は、変異解析用データと、発現差解析用データを使います。それぞれzip形式で圧縮されて
いますが、圧縮された状態のまま、以下のImport > Standard Import よりインポートしてくださ
い。 



Sample to Insight 

変異解析フロー 

Title, Location, Date 5 

全体の流れ 

インポート 

QC、トリミング 

マッピング 

マッピング補正 

変異解析 

アノテーション 

フィルタリング 
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CLC Genomics Workbench 
データインポート 



Sample to Insight 

データインポート 
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リードデータインポート 

SAM/BAMインポート* 

シークエンサーデータインポート 

SAM/BAMファイルは、マッピング後のデータにおいて利用される一般的なフォーマットです。 

次世代シークエンサー以外のファイル 

アノテーションファイルのインポート 
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データインポート 
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リードデータインポート：イルミナ 

 

• リードファイルの選択 

General options：共通のオプション 
• Paired reads: ペアかどうか 
• Discard reads names: リード名を捨てる

かどうか（捨てないことをお勧め） 
• Discard quality scores: クオリティスコ

アを捨てるかどうか（捨てないことをお
勧め） 

Paired options：ペアのオプション 
• Paired-end: ペアエンドかどうか 
• Mate-pair: メイトペアかどうか 
 
ペアを選んだ場合はリード長を含めた距離
を入力。 

古いバージョンのIlluminaのソフトウェアで処理
されたデータの場合は、バージョンを指定。 
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データインポート 
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リードデータインポート：イルミナ 

 

Result handling：結果の扱い方 
• Open: インポート後開く 
• Save: インポートして保存 

• Into separate folders: データごとに

フォルダを作成するかどうか。複数
ファイルをインポートする場合は、
チェックを入れておくことで、デー
タごとにフォルダが作成され、管理
が容易になります。 
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データインポート 
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リードデータインポート：Ion Torrent 

 

• リードファイルの選択 

General options：共通のオプション 
• Paired reads: ペアかどうか 
• Discard reads names: リード名を捨てる

かどうか（捨てないことをお勧め） 
• Discard quality scores: クオリティスコ

アを捨てるかどうか（捨てないことをお
勧め） 

Paired options：ペアのオプション 
• Paired-end: ペアエンドかどうか 
• Mate-pair: メイトペアかどうか 
 
ペアを選んだ場合はリード長を含めた距離
を入力。 

Ion Torrent オプション: .sffファイルでのインポー
トの場合、Clippingされた情報を使うかどうか、
選択できる。 

• Fastqかsffを選択可能 
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データインポート 
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リードデータインポート：Ion Torrent 

 

Result handling：結果の扱い方 
• Open: インポート後開く 
• Save: インポートして保存 

• Into separate folders: データごと
にフォルダを作成するかどうか。
複数ファイルをインポートする場
合は、チェックを入れておくこと
で、データごとにフォルダが作成
され、管理が容易になります。 
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データインポート 
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リードデータインポート：Ion Torrent (Unmapped BAMファイル) ※注意 

 

 
Ion Torrentのシークエンサーデータを処理するTorrent Suitでは、バージョン3.0以降、デフォル
トでは、fastqファイルやsffファイルが作成されず、Unmapped BAM ファイルが作成されます。
Unmapped BAM ファイルは、Import > Standard Import よりインポートいただくことで、fastq
ファイルをインポートした場合と同じようにインポートが可能です。 

 

 

マッピングデータとしてインポートされます。 

リードデータとしてインポートされます。 
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データインポート 
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ゲノムインポート 

ゲノムデータは、よく知られているモデル動物についてはのDownload Genome よりインポー
トできます。 
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ゲノム配列の入手方法 

• Download 機能を用いる 

• Download サイトからダウンロードしたファイルをインポー
トする 

または 

データインポート 
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データインポート 
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ゲノムインポート 

 

• ドロップダウンリストから生物種を選択。 

• Download genome sequence: 新規にゲノム
をダウンロードする場合。 

• Use exsting genome sequence track: すでに

ダウンロードしたゲノムにアノテーションを
追加する場合。以下のようにトラックの
フォーマットになっているゲノムを選択。 
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データインポート 
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ゲノムインポート 

 

• 希望するアノテーションにチェックを入れる。ゲノム配列をダウンロードする
ときは、Sequences にもチェックを入れる。 

• 選択した生物種により、表示されるアノテーションの種類は異なります。 
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NCBIで検索してインポート   

または 

• NCBI のサイトに検索をかけて、直接ゲノム配列を
ダウンロードすることができます 

データインポート 
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• 検索のキーワードを入れて、Start search をクリックします 
• 目的の配列を選択して、Download and Save で配列をダウンロードできます 

Search for Sequences at NCBI   

データインポート 
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データインポート 
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アノテーションインポート 

• Download Genome 以外にも、アノテーションファイルをインポート可能です。 

• アノテーションとして取り込めるファイルは以下のフォーマットです。 

• アノテーションファイルをインポートする際には、対象となるゲノム配列がすでにインポー
トされ、Trackのフォーマットになっていることが前提です。 

 
• VCF 
• GFF/GTF/GVF 
• BED 
• Wiggle 
• Complete Genomics Var file 
• UCSC Variation table damp 
• COSMIC variation database 

 
 

※変異のデータについても、アノテーションとして自分の変異へアノテーションとして情報の
追加や比較ができるため、アノテーションのインポート可能フォーマットに含めています。 
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データインポート 
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アノテーションインポート 

アノテーションのインポートは、Import > Tracks より行います。 



Sample to Insight 

データインポート 
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トラックインポート 

インポートするファイルのタイ
プを選択 

インポートするファイルを選択 

対象とする参照配列（ゲノム配列）を選択。あ
らかじめインポートされている必要があります。 
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データフォーマット編 
スタンドアロンフォーマットと 

トラックフォーマット 
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スタンドアロンフォーマット 
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スタンドアロンフォーマットでは、1つのデータに配列情報、アノテーションがセットになっ
ています。 



Sample to Insight 

トラックフォーマット 
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トラックフォーマットでは、リードやゲノム配列、アノテーションがばらばらのファイルに
なっており、好きに組み合わせて表示が可能です。 
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トラックリスト 
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複数のトラックを組み合わせてTrack list を作ることで好きなビューを作成できます。 
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フォーマットとアイコン表示 
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ゲノムTrack 

アノテーションTrack 

変異Track 

リード（マッピング）Track 

染色体のセットやリード配列など配列のセット 

染色体1本など１つの配列 

リードマッピング 

スタンドアロンフォーマット 

トラックフォーマット 青いヒストグラムが目印 

解析によって必要とするフォーマットが異なります。 
スタンドアロン⇔トラックの変換は自由に行えます。 
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フォーマットの変換 
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トラックフォーマットからスタンドアロンフォーマット、またスタンドアロンフォーマットか
らトラックフォーマットへは、 Toolbox > Track tools の中のツールを使って変換可能です。 

• トラックからスタンドアロンフォーマットへの変換。 

• スタンドアロンフォーマットからトラックへの変換。 
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フォーマットの変換 
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トラックフォーマットからスタンドアロンフォーマット、またスタンドア
ロンフォーマットからトラックフォーマットへは、 Toolbox > Track tools 
の中のツールを使って変換可能です。 

• トラックからスタンドアロンフォーマットへの変換。 

• スタンドアロンフォーマットからトラックへの変換。 

スタンドアロンフォーマットへ変換する場合、スタンドア
ロン内に含めるアノテーショントラックを含めて変換す
るようにしてください。 
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フォーマットの変換 
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スタンドアロンフォーマットへ変換する場合、スタンドアロン内に含める
アノテーショントラックを含めて変換するようにしてください。 

• スタンドアロンフォーマットでは、Setting Panel の
Annotation Type からどういったアノテーションが
付属しているか確認できます。 
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クオリティチェックとトリミング 
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クオリティチェックとトリミング 
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Quality Report作成: Create Sequencing QC Report 
• インポートしたリードのクオリティがどのぐらいか、その後のトリミングや、PCR 

Duplicate の状況などを確認するためにレポートを作成。 

トリミング: Trim Sequences 
• アダプターの除去、クオリティスコアによる除去、長さを指定した除去などを選択・組み

合わせてトリミング。 
 

上記処理の後に再度Quality Reportを作成すると処理前と処理後での
リードのクオリティを比較でき、便利です。 

 

 



Sample to Insight 

クオリティトリミング：原理 

32 

クオリティスコア 

シークエンサーから出てきたリードは、各塩基ごとにエラーの確率の値を持っている。 

Genomics Workbench へインポートされた時点で、Phred Score に変換されるようになってい
ます。Pred Score は、塩基のエラー確率のLogを取り、-10をかけてスコア化したものです。値
が大きくなるほど精度が高いことをあらわしています。 

Phred Score Error の確率 Base call の精度 

10 1/10 90% 
20 1/100 99% 
30 1/1,000 99.9% 
40 1/10,000 99.99% 
50 1/100,000 99.999% 
60 1/1,000,000 99.9999% 
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QCレポート作成：Create Sequencing QC Report 

33 

• Navigation Areaから使用するリードデータを選択。 
• Toolboxから NGS Core Tools > Create Sequencing QC Report 

を選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 



Sample to Insight 

QCレポート作成：Create Sequencing QC Report 
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• Quality analysis: クオリティスコアに関する解析。 
• Over-representations analysis: 過度に現れている
ような塩基配列などの解析。 

• Create graphical report: グラフィカルなレポート
作成。 

• Create supplementary report: 数値のレポート作成。 
• Create duplicated sequence list: 重複のあった配列
のリスト作成。 



Sample to Insight 

QCレポート作成：Create Sequencing QC Report 
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トリミング原理 
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3種類のトリミング 

• あらかじめ登録されているアダプターの除去 
• 新規で独自の配列を登録することも可能 アダプター除去 

• Quality Score を使い、Quality の低い配列が連続
するようになる箇所からカット 

• 正確に読めていない塩基をいくつ許容するか 
クオリティトリミング 

• 塩基数を指定して、5末端、3末端をカット 
• Quality Scoreでカット後、短くなりすぎた配列を
カット 

長さによる除去 
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クオリティトリミング：原理 
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クオリティスコア 

Trimming ではQuality Score を使い、累積のQuality Score がある一定の値よ
り大きいものが続いた場合に、その箇所を取り除く、という処理を行います。 
 
具体的には以下： 

1. Phred Score をp値へ変換 
 
 
 
 

2. Trimming 中に設定するパラメータ（Limit）とp値の差を計算 
3. 差の累積和を計算。このとき、0以下の値は0とする 
4. Trimming後のリード開始点は累積和がはじめて0以上になった点。Trimming後のリー

ド終了点は累積和が最大の点 
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0 

20 

40 

1 2 3 4 5 6 7 8 9 10 11 12 13 14 15 

リード配列 G  C  C  C  A  T  G  T  T  C  G  A  T  G  C  
Phred score 4 8 15 30 32 23 10 31 31 20 15 11 10 10 9 
p値 0.40 0.16 0.03 0.00 0.00 0.01 0.10 0.00 0.00 0.01 0.03 0.08 0.10 0.10 0.13 
Limit - p値 (D) -0.35 -0.11 0.02 0.05 0.05 0.04 -0.05 0.05 0.05 0.04 0.02 -0.03 -0.05 -0.05 -0.08 
 (D)の累積和 0.00 0.00 0.02 0.07 0.12 0.16 0.11 0.16 0.21 0.25 0.27 0.24 0.19 0.14 0.06 

スタート点： 
累積和が0より大き
くなった塩基 

終了点： 
累積和が最大を
示す塩基 

Phred score の棒グラフ 

グラフより、ある程度クオリティが高くなった場所からリードを使い、クオリティが
連続して悪くなっている箇所からリードをトリムしていることがわかる。 
※途中、1塩基のみクオリティが低いような場合は、必ずしもトリムされない。これは
できるだけリードを長く保とうとするため。 

Limit = 0.05の場合 

クオリティトリミング：原理 

原理 

38 
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トリミング 
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• Navigation Areaから使用するデータを選択。 
• Toolboxから Trim Sequences を選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 
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トリミング 
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クオリティトリミング 

• Trim using quality scores ：トリミ
ングに使用するLimitパラメータを
決定 

• Trim ambiguous nucleotides：N表
示される塩基について、最大何塩
基まで保持させるか。 

• 今回はアダプターは設定なし。 
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トリミング 
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長さによるトリミング 

• 5末、3末の塩基数を指定してカットする 
• Quality Scoreによるトリミングであまりに短いリードの除去など長さによるトリミング 
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トリミング結果 
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結果 

• トリミング後は、トリムされたリードと、レポートを
作成した場合は、そのレポートが作成されます。 

• トリミング結果のデータはファイル名の後に 
trimmed という名前が付いています。ファイル
内容はインポート後のデータ同様に、配列と、
クオリティスコアを含んだファイルとなってい
ます。 
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トリミングレポート 
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結果 
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QCレポート 再作成による比較 
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エクササイズ 

• トリミング後のデータでレポートを作成してみましょう！ 

Before  After 
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アダプタートリミング：アダプターの指定 

File > New > Trim Adapter List 

45 

• Name:アダプターの名前 
• Sequcence: アダプターの配列 
• Strand 

• Alignment scores costs: ミス
マッチとギャップに対するペナ
ルティのコスト 

• Match thresholds: internal また
は end のマッチに対する 
criteria 

• アダプターが見つかっ
た場合のアクションの
指定 

45 
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マッピング  
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マッピング原理 
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2つのステップ 

1. ローカルアライメント 

参照配列と似ている場所を探す 

 

 

 

 

 

2. フィルタリング 

どの程度参照配列と一致しているリードをその後の解析に残すか 
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マッピング原理 
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マッピング原理 

スコアリング 
最適なマップ場所をLocal Alignmentで探索 

 
   Match = 1, Mismatch cost = 2  

 
  

 リード配列（20bp）が全て一致した場合 

 

 

 

 

 

CGTATCAATCGATTACGCTATGAATG 
   |||||||||||||||||||| 
   ATCAATCGATTACGCTATGA 

アライメントスコア = 20  
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マッピング原理 
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マッピング原理 

スコアリング 
 

 

 

 

 

CGTATCAATCGATTACGCTATGAATG 
    ||||||||||||||||||| 
   TTCAATCGATTACGCTATGA 

CGTATCAATCGATTACGCTATGAATG 
    |||||| |||||||||||| 
   TTCAATCAATTACGCTATGA 

CGTATCAATCGATTACGCTATGAATG 
    |||||| ||| ||||||| 
   TTCAATCAATTGCGCTATGC 

アライメントスコア = 19  

アライメントスコア = 16  

アライメントスコア = 10  
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マッピング原理 
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フィルタリング 

 
最も高いアライメントスコアにマップされたリードのうち、どの程度参照配列と類似している
リードをその後の解析に残すのかを決定します。 



Sample to Insight 

マッピング原理 
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Linear gap とAffine gap 

AATTCGCGCGGCATTCGCGCC 
AAATCG----GCATTCGCGCC 

50 match 50 + 6 + 4 x (-3) + 11 = 55 

50 + 6  = 56 

AATTCGCGCGGCATTCGCGCC 
AAATCG----GCATTCGCGCC 

AATTCGCGCGGCATTCGCGCC 
AAATCG----GCATTCGCGCC 

50 + 6 + (-6) + 4 x (-1) + 11  = 57 

Read 

Genome 

Affine Gap costを使った場合 （Gap open = 6, Gap extend = 1） 

Linear gap cost の場合（Deletionコストが３の場合） 

A 

B 

C 

これまでのマッピングでは、Aのように本来マッピングすべきような場合でも、リードの末端部分をア
ライメントしない（Bのブルーの箇所）場合のほうが、アライメントスコアが高くなるため、大きな挿
入や欠失がうまくマップできていないことがありました。アフィンGapコストの場合、このような問題
を防ぐことができます。またGapを開くときのコスト（Open）と延長するときのコスト（Extend）が別
に設定できることで、より細かくコントロールが可能になる場合があります。 
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マッピング原理 
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フィルタリング原理 

Length FractionとSimilarity パラメータを使って、どの程度アライメントされたリードを、マッ
ピングされたものとして保持するか、決定します。 

Length Fraction とSimilarity は２つのパラメータの組み合わせで使用されます。 

Length fraction: フィルターをかける際に、考慮する長さ 

Similarity: Length Fraction で指定した長さのうち、どの程度類似しているものを残すか。 

リード長：100 bp 

デフォルトのLength Fraction, 0.5  100 bp x 0.5 = 50 bp, 
デフォルトのSimilarity 0.8    50bp x 0.8 = 40      50塩基中40塩基が完全一致して
いることがフィルタリングの条件となる  

Reference 
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マッピング原理 
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２つのパラメータを使う理由 

 
 

 
 

– リードの一部は似ているけれども、大きな挿入や、欠失によりリードの一部が参照配列と一致
しない可能性がある場合 

– トリミングが完全にできなかったクオリティの低い配列が末端部にある場合 
（Length Fraction を小さくすることで、リードの一部に限定してアライメントの類似度を設定できる） 

 
 
 

 
 

 
– 参照配列とほぼ一致するが、所々、１塩基の変異があると想定される場合 

 

Reference 

Reference 
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マッピング 
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• Navigation Areaから使用するデータを選択。 
• Toolboxから NGS Core Tools > Map Reads to Reference を選択、ダブルク

リック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 



Sample to Insight 

マッピング 
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• Referenceに使用する
データを選択。 

• Reference:使用する参照配列を選択。 
• Reference masking 

Exclude annotated：あるアノテーション
を除外したい場合。 
Include annotated only: あるアノテー
ションのみ含みたい場合。 



Sample to Insight 

Mapping parameters: Linear Gap cost  
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Filter の parameter  

Mismatch の penalty 

Insertion/deletion の 
penalty (Linear) 



Sample to Insight 

Mapping parameters: Affine gap cost 

57 

Insertion, Deletion 開始時点でカウントされるコスト（Insertion/Deletion open cost）と 
Insertion, Deletionが1塩基長くなる際に増えるコスト（Insertion/Deletion extended cost） 

Insertion/deletion の 
penalty (Affine) 



Sample to Insight 

マッピング 
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• Mismatch cost：アライメントにマッチしないものがあった
場合のコスト 

• Insertion cost：アライメントに挿入がある場合のコスト 
• Deletion cost:アライメントに欠失がある場合のコスト 
• Insertion open cost: 挿入を開始する場合のコスト 
• Insertion extend cost: 挿入を延長する場合のコスト 
• Deletion open cost: 欠失を開始する場合のコスト 
• Deletion extend cost: 欠失を延長する場合のコスト 
• Length fraction：リードの長さのどの程度がマッピングされ

ているべきか。 
• Similarity :どの程度類似しているべきか。 
• Global alignment:  

Global alignment を行うかどうか。チェックが外れている場
合はLocal alignmentを実行。 

• Color space alignment:カラースペースのデータかどうか、
その場合にカラーによるエラー補正を行うかどうか。 

• Auto-detect paired distances: 自動でペアの距離を決めるか
どうか。 

• Non-specific match handling：同一スコアでマップ
される箇所がある場合の対処。 



Sample to Insight 

マッピング 
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• Create reads track: 結果をトラックと
して作成する場合。 

• Create stand-alone read mappings：結
果をstand-aloneフォーマット（参照配
列、リードマッピング、アノテーショ
ンが一つになったファイル）で作成す
るか。 

• Create report:マッピング結果のレポー
ト作成。 

• Collect un-mapped reads:マップされな
かったリードをリストとして作成する
かどうか（リスト化することにより、
De Novoなど、別の解析へ利用可能） 



Sample to Insight 

マッピング：結果 
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結果のトラック 

トラック 

Tool バー 

選択ツール 

拡大ツール 

スライドズーム 

縮小して全体表示ボタン 



Sample to Insight 

マッピング：結果 
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• 色がうすくなっている箇所
はマッピングされていませ
ん⇒カバレッジの計算にも
考慮されていません。 

• 背景に色が付いている箇
所は、参照配列と異なる
箇所です。 

• 緑色のリードは、センス鎖にマッ
プされたリード、赤色のリードは
アンチセンス鎖へマップされた
リードになります。青色のリード
は、ペアとして認識されている
リードです。 



Sample to Insight 

マッピング：レポート 
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基本の Report は「Summary Report」という名前で保存されています。 

  



Sample to Insight 

マッピング：Track list の作成 
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参照配列の追加 

リードマッピングの結果に参照配列を追加しましょう。 

 



Sample to Insight 

マッピング：Track list の作成 
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• マッピングに使用したゲノムを選択。 
• ゲノム（参照配列）のアイコンが    

の  ような場合、Track Tools > 
Convert to Track を使って、変換を
行ってください。 

• 追加されたゲノムトラック
と遺伝子トラック 

• ドラッグアンドドロップで簡単に位置を変
更できます。 



Sample to Insight 
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Local Realignment 



Sample to Insight 

Local Realignment 
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原理 

マッピングのプロセスでは、各リードがもっとも高いアライメントスコア（参照配列との一致
度を示すスコア）を示す場所にマッピングをしています。しかしながら、時には近傍のリード
のマッピングの状況から、最も高いアライメントスコアではなくとも、もっともらしいマッピ
ング結果が考えられる場合があります。 

 

 

 

 

 

 

 

 

たとえば上記例では、GCCGは左横にずれることで、他のリードのマッピングとも一致し 
もっともらしいマッピングになると考えられます。マッピングの段階では、各々のリードのア
ライメントスコアのみを考えているため、このような状況が発生します。 

さらにこの状況で変異やInsertion、Deletionの検出を行うと、正しく検出できない 
ものも発生します。特にInsertionやDeletionが影響をうけると考えられています。 

 

 



Sample to Insight 

Local Realignment 

67 

原理 

• Local Realignment では、このような状況を修正するため、マッピングを部分的にやり直し
ます。この際、通常のマッピングの段階とは異なり、他のリードのマッピング状況を考慮す
るため、先ほどのマッピングは以下のように変化します。 

 

 

 

 

 

 

 

 

 

• 先ほどのマッピングよりも、こちらの方がもっともらしい結果であることが直感的に分かり
ます。 

 

 



Sample to Insight 

Local Realignment 

68 

• Toolbox > NGS Core Tools >  
Local Realignment 

• 2種類のLocal Realignmentsがありま
す。さらにGuided にNo forceとForce
の2種類があります。 

– Non guided 

– Guided  

• No force 

• Force 

 



Sample to Insight 

Local Realignment 

69 

Guided Local Realignment 

 
• ガイドとなるような変異（InsertionやDeletion）の情報をあらかじめ与えておくことで、

その領域のInsertion、Deletionを考慮してリアライメントを行う。 

• ガイドとなる変異情報がない場合、Local Realignment では、少なくとも1本のリードが
InsertionやDeletionを支持している必要がある。このような場合、ガイドとなる変異情
報を与えることで、InsertionやDeletion を効率的に検出できるようになる。 

• Guided Local Realignment が有効な例 

 

 



Sample to Insight 

Local Realignment 実行方法 
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• Navigation Areaから使用するマッピングデータを選択。 
• Toolboxから NGS Core Tools > Local Realignment を選択、ダブル

クリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 



Sample to Insight 

Local Realignment 実行方法 
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• Realign unaligned ends: マッピングの際に
マップされなかった末端（soft clipping）
をLocal Realignment の際に利用するかど
うか。アダプターの一部のようなものが
残っていない限り、ここはチェックを入れ
る。 
 

• Guidance-variant settings：ガイダンスあ
り、なしの設定 

• Guidance-variant track: ガイダンスに使用
するトラックを選択。 

Force realignment to guidance-variants: 
ここにチェックを入れることで、より積
極的にRealignmentを行える。 



Sample to Insight 

Local Realignment 実行方法 

72 

• Output options アウトプットの選択 
Create reads track: トラックフォーマットで
の作成。 
Create stand-alone read mappings: スタン
ドアロンフォーマットでの作成。 

Output track of realigned regions: 
Realignmentされた個所をトラックとし
て保存するかどうか。確認に便利。 

 
• Result handling 

Open: 実行後すぐに開く。 
Save: 実行後一旦保存。 
 

• Log handling 
Make log: ログを作成するかどうか。 



Sample to Insight 

Local Realignment：結果 
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• 結果はマッピングのファイルとして作成され、名前の最後に locally realigned と
して作成されます。 
– スタンドアロンフォーマットで作成した場合 

 
 

– トラックフォーマットで作成した場合 
 
 

• この後、通常と同じ方法で変異やInsertion, Deletion の検出を行います。 
 

 



Sample to Insight 
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変異検出  



Sample to Insight 

SNV検出 
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3種類の variant detection tools 

Basic Variant Detection ：クオリティと、バリアントの見られる頻度からバリアントのサイト
を検出 
(version 7.5以前のQuality-Based Variant Detection) 

  

Fixed Ploidy Variant Detection：確率モデルを使い、バリアントのサイトを検出 
(version 7.5以前のProbabilistic Variant Detection)  

 

Low Frequency Variant Detection：低頻度で見られるバリアントの検出ツール。倍数性を指
定しないでバリアントの検出が行える。 

  

使い分け： 

バリアントの見られる頻度が、その領域において15％以下のような場合は、Basic Variant 
Detection, それよりも多い場合は、Fixed Ploidy Variant Detection をご利用ください。バリアン
トの見られる頻度が低い場合や、倍数性を指定できない場合などは、Low Frequency Variant 
Detection をご利用ください。 

 

 



Sample to Insight 

フィルター：General Filter 
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共通フィルター 

 

Reference masking 
Ignore positions with coverage above：カバレッジが
指定した数字以上のバリアントについてリストに含
めない 
Restrict calling to target regions：バリアントを検出
したい領域の指定（アノテーショントラックで指
定） 
 

Read filters 
• Ignore broken pairs：ペアエンドのリードでペア

と認識されなかったリードをバリアント検出の計
算に含めるかどうか 

• Ignore non-specific matches：「Reads」を選択す
ると、non-specificなマッチのリードを計算に含め
なくなり、「Regions」を選択すると、1本でも
non-specificなリードが含まれる場合、その領域の
バリアントを検出しません。 

• Minimum read length：Ignore broken pairとIgnore 
non-specific regions が指定された場合、このフィ
ルターの対象となる最小のリードの長さの設定が
必要です。これは非常に短いリードは、その短さ
からnon-specificになる可能性があるためです。 



Sample to Insight 

フィルター：General Filter 
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共通フィルター 

Coverage and count filters 
• Minimum coverage：最小カバレッジ 
• Minimum count：バリアントを支持するリードの最低
カウント数 

• Minimum frequency (%)：最小頻度 



Sample to Insight 

フィルター：Noise Filters 
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共通フィルター 

78 

• Quality filter 
Base quality filter:塩基のクオリティに関するフィルター 

Neighborhood radius：クオリティフィルターの対象
とする横方向の塩基数（奇数） 
Minimum central quality：縦方向の数（リード数） 
Minimum neighborhood quality：Neighborhood 
radiusで指定した範囲の最低クオリティ（Phred 
score） 
 



Sample to Insight 

フィルター：Noise Filters 
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共通フィルター 

79 

• Direction and position filters：リードの方向（Forward
とReverse）とポジションを使ったフィルター 

Read direction filter：どちらか一方の方向のリードが
多数見られる場合にそれを排除（ただし、アンプリ
コンには適していません）。 
Relative read direction filter：リードの方向が一方の
みに偏りすぎていないか、全体のForwardとReverse
のバランスを見て統計検定を行う。Significanceで閾
値を入力。 
Read position filter：システマティックなエラーを取
り除くために用いるツールでハイブリダイゼーショ
ンを行った場合のデータに有効。リードを5つのセグ
メントに分割し、バリアントの見られるポジション
の５つのセグメントに分割されたリードの分布が全
体のそれと似ているかどうか検定を行う。
Significanceで閾値を入力。＊詳細は後述 



Sample to Insight 

フィルター：Noise Filters 
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共通フィルター 

80 

• Technology specific filters 
Remove pyro-error variants：ホモポリマー領域
に対するエラーの除去 

In homopolymer regions with minimum 
length：指定した長さのホモポリマー領域の
InDelを取り除く。 
With frequency below：指定した頻度以下の
ものについてのみフィルターを適用。 



Sample to Insight 

Base quality filter 
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フィルター例 

• Base quality filter 適用例：マッピングしたリードをクオリティで表示。
クオリティの低いリードがマップされている箇所がバリアントのリスト
からはずされます。 



Sample to Insight 

Read direction 
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フィルター例 

• Read direction filter 適用例：リー
ドの色は緑（Forward）、赤
（Reverse）、黄色（non-
specific）を示しており、緑の
リードが大部分のバリアントをサ
ポートしていることがわかる。こ
ういったアンバランスな箇所で検
出されたバリアントが取り除かれ
る。 



Sample to Insight 

Read position filter 
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原理 

• もしリードが理想的な均一なカバレッジであれば、検出されるバリアントをサポートする塩基のリード
中の位置は、さまざまになるはずです。 

 

 

 

 

 

 

 

• これを使い、リードをForward、Reverseの向きを 
考慮して、それぞれ5分割、計10個の領域に分断し、 
変異が見つかった箇所がリードのどの領域に 
属するか、それらの分布が全体と大きく差がないか 
を検定しています 

 



Sample to Insight 

Read position filter 
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フィルター例 

• Read position filter 適用例：バリアン
トをサポートしているリードがリード
の同じ位置で検出されているため、こ
のバリアントはRead position filter に
より除去されます。 



Sample to Insight 

Basic Variant Detection 
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変異検出ツールでは、フィルターの条件をクリアした場合に variant をコールします 
 
 
 



Sample to Insight 

Basic Variant Detection 

86 

• Navigation Areaからマッピングデータを選択。 
• Toolboxから Resequencing Analysis > Variant Detectors > Basic 

Variant Detection を選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確

認。 



Sample to Insight 

Basic Variant Detection 
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• Ploidy: 参照配列の倍数性 



Sample to Insight 

Basic Variant Detection 
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Reference masking 
• Ignore positions with coverage above：

カバレッジが指定した数字以上のバリ
アントについてリストに含めない 

• Restrict calling to target regions：バリ
アントを検出したい領域の指定（アノ
テーショントラックで指定） 



Sample to Insight 

Basic Variant Detection 

89 

Read filters 
• Ignore broken pairs：ペアエンドのリー

ドでペアと認識されなかったリードを
バリアント検出の計算に含めるかどう
か 

• Ignore non-specific matches：
「Reads」を選択すると、non-specific
なマッチのリードを計算に含めなくな
り、「Regions」を選択すると、1本で
もnon-specificなリードが含まれる場
合、その領域のバリアントを検出しま
せん。 

• Minimum read length：Ignore broken 
pairとIgnore non-specific regions が指
定された場合、このフィルターの対象
となる最小のリードの長さの設定が必
要です。これは非常に短いリードは、
その短さからnon-specificになる可能性
があるためです。 



Sample to Insight 

Basic Variant Detection 

90 

Coverage and count filters 
Minimum coverage：最小カバレッジ 
Minimum count：バリアントを支持する
リードの最低カウント数 
Minimum frequency (%)：最小頻度 



Sample to Insight 

Basic Variant Detection 

91 
91 

Quality filter 
• Base quality filter:塩基のクオリティに

関するフィルター 
• Neighborhood radius：クオリティ

フィルターの対象とする横方向の
塩基数（奇数） 

• Minimum central quality：縦方向の
数（リード数） 

• Minimum neighborhood quality：
Neighborhood radiusで指定した範
囲の最低クオリティ（Phred 
score） 



Sample to Insight 

Basic Variant Detection 

92 
92 

Direction and position filters： 
• Read direction filter：どちらか一方の方向の

リードが多数見られる場合にそれを排除（た
だし、アンプリコンには適していません）。 

• Relative read direction filter：リードの
方向が一方のみに偏りすぎていないか、
全体のForwardとReverseのバランスを
見て統計検定を行う。Significanceで閾
値を入力。 

• Read position filter：システマティック
なエラーを取り除くために用いるツー
ルでハイブリダイゼーションを行った
場合のデータに有効。リードを5つのセ
グメントに分割し、バリアントの見ら
れるポジションの５つのセグメントに
分割されたリードの分布が全体のそれ
と似ているかどうか検定を行う。
Significanceで閾値を入力。 

 



Sample to Insight 

Basic Variant Detection 

93 
93 

Technology specific filters 
• Remove pyro-error variants：ホモポリ

マー領域に対するエラーの除去 
• In homopolymer regions with 

minimum length：指定した長さの
ホモポリマー領域のInDelを取り除
く。 

• With frequency below：指定した
頻度以下のものについてのみフィ
ルターを適用。 



Sample to Insight 

Basic Variant Detection 
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• Create track: トラックの作成 
• Create annotated table: アノテーション付の

テーブルの作成 



Sample to Insight 

Basic Variant Detection 

95 

結果 

• 結果はデフォルトではトラックフォーマットになっています。 

• 左下のテーブルアイコンをクリックするとテーブルに代わります。 



Sample to Insight 

• Count: クオリティのフィルターをパスしたリードの数 
• Coverage: クオリティのフィルターをパスしたリードの数 
• Frequency: バリアントが見られた頻度 
• Probability: バリアントのアレルの事後確率（そのアレルが尤もであるとする

確率。高い方がより確度が高いという事。） 
• Forward reads: その領域に見られたForwardリードの数 
• Reverse reads:その領域に見られたReverseリードの数  
• Forward/reverse: Forward/Total reads または Reverse/Total reads のうち

小さい方の値。ForwardとReverseが同じなら、0.5となる。 
• Average quality: 該当する領域の平均リードクオリティ。  
• # unique start positions:バリアントコールに使われたリードのうちスタートポ

ジションにあるリードの数 
• # unique end positions:バリアントコールに使われたリードのうち最後の箇所

にあるリードの数 
• BaseQRankSum:クオリティスコアについて、参照配列と同じアレルとバア

リアントのアレルについてマンホイットニーU検定を行い計算されたZスコ
ア。これが高いほど参照配列の塩基とバリアントの塩基に差がある。 

• Hyper-alleic：想定されるアレルよりも頻度が高いかどうか 
• Homopolymer：ホモポリマー領域かどうか 

Basic Variant Detection：結果 

96 



Sample to Insight 

Basic Variant Detection 
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トラックリストの作成 



Sample to Insight 

Basic Variant Detection 
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トラックリスト作成 

• Navigation Areaからマッピングデータとバリアントの結果を選択。 
• Toolboxから ResequTrack Tools > Create Track List を選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 



Sample to Insight 

Basic Variant Detection 
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トラックリストの作成 

• バリアントのトラックの名前のところで
ダブルクリック 

• テーブルが現れます。テーブルの行と、マッピングの
ビューアは対応しているので、テーブルで指定したポジ
ションに自動的にビューアが移動します。 



Sample to Insight 

Fixed Ploidy Variant Detection 
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Probabilistic Variant Detection 

• 確率モデル（Bayes model）を使ったバリアント検出 
 
 
 
 
 
 
 
 

                 与えられるリードから、そのポジションのSite Typeを推定 
  Reference と推定したSite typeが異なる場合、バリアントとして結果 

 返す。 
 

 

 

                             A 

A 
A 
T 
T 
C 

? 

? : Site type (ex) A/A, A/T, A/C 
... ?  

Reference 



Sample to Insight 

Fixed Ploidy Variant Detection 
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Fixed Ploidy Variant Detection 
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: Error Model を使って推定   

: Genome Model を使って推定 



Sample to Insight 

Reference がAのとき、Readの大部分はAになると仮定し、初期の確率を以下のよ
うに設定し、EMアルゴリズムを使ってそれぞれの確率を推定する。 

EMアルゴリズム（Expectation Maximization algorithm）は、得られたデータから推定したい現象が
観察できない場合に、その確率を推定する、一般的な統計の手法。 

 
 
 
 
 
 
 
 

 
 
 
 

 

Fixed Ploidy Variant Detection 
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Genome Model 
 

Site Type Initial Probability 
A/A 0.2475 
A/C 0.001 
A/G 0.001 
A/T 0.001 
T/C 0.001 
T/G 0.001 
T/T 0.2475 
G/C 0.001 
C/C 0.2475 
G/G 0.2475 
G/- 0.001 
A/- 0.001 
C/- 0.001 
T/- 0.001 



Sample to Insight 

Fixed Ploidy Variant Detection 
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Error Model 

– リードに含まれるエラーを考慮するため、尤度のところにエラーを考慮した確率を推
定する。初期値を以下のように設定し、EMアルゴリズムにて確率を推定する。 
 

 
Reference 

A C G T - 
Reads 

A 0.90 0.025 0.025 0.025 0.025 
C 0.025 0.90 0.025 0.025 0.025 
G 0.025 0.025 0.90 0.025 0.025 
T 0.025 0.025 0.025 0.90 0.025 
- 0.025 0.025 0.025 0.025 0.90 
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Fixed Ploidy Variant Detection 
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• Navigation Areaからマッピングデータを選択。 
• Toolboxから Resequencing Analysis > Variant Detectors > Fixed Ploidy 

Variant Detection を選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 



Sample to Insight 

Fixed Ploidy Variant Detection 
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Ploidy：参照配列の倍数性 
• Required variant probability：バリアン

トが参照配列と異なる確率（想定で入
力）。この値を低くすると、検出され
るバリアントが多くなります。 



Sample to Insight 

Fixed Ploidy Variant Detection 
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Reference masking 
• Ignore positions with coverage above：

カバレッジが指定した数字以上のバリ
アントについてリストに含めない 

• Restrict calling to target regions：バリ
アントを検出したい領域の指定（アノ
テーショントラックで指定） 



Sample to Insight 

Fixed Ploidy Variant Detection 
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Read filters 
• Ignore broken pairs：ペアエンドのリー

ドでペアと認識されなかったリードを
バリアント検出の計算に含めるかどう
か 

• Ignore non-specific matches：
「Reads」を選択すると、non-specific
なマッチのリードを計算に含めなくな
り、「Regions」を選択すると、1本で
もnon-specificなリードが含まれる場
合、その領域のバリアントを検出しま
せん。 

• Minimum read length：Ignore broken 
pairとIgnore non-specific regions が指
定された場合、このフィルターの対象
となる最小のリードの長さの設定が必
要です。これは非常に短いリードは、
その短さからnon-specificになる可能性
があるためです。 



Sample to Insight 

Fixed Ploidy Variant Detection 
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Coverage and count filters 
Minimum coverage：最小カバレッジ 
Minimum count：バリアントを支持する
リードの最低カウント数 
Minimum frequency (%)：最小頻度 
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Fixed Ploidy Variant Detection 
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Quality filter 
• Base quality filter:塩基のクオリティに

関するフィルター 
• Neighborhood radius：クオリティ

フィルターの対象とする横方向の
塩基数（奇数） 

• Minimum central quality：縦方向の
数（リード数） 

• Minimum neighborhood quality：
Neighborhood radiusで指定した範
囲の最低クオリティ（Phred 
score） 
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Fixed Ploidy Variant Detection 
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Direction and position filters： 
• Read direction filter：どちらか一方の方向の

リードが多数見られる場合にそれを排除（た
だし、アンプリコンには適していません）。 

• Relative read direction filter：リードの
方向が一方のみに偏りすぎていないか、
全体のForwardとReverseのバランスを
見て統計検定を行う。Significanceで閾
値を入力。 

• Read position filter：システマティック
なエラーを取り除くために用いるツー
ルでハイブリダイゼーションを行った
場合のデータに有効。リードを5つのセ
グメントに分割し、バリアントの見ら
れるポジションの５つのセグメントに
分割されたリードの分布が全体のそれ
と似ているかどうか検定を行う。
Significanceで閾値を入力。 
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Fixed Ploidy Variant Detection 
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Technology specific filters 
• Remove pyro-error variants：ホモポリ

マー領域に対するエラーの除去 
• In homopolymer regions with 

minimum length：指定した長さの
ホモポリマー領域のInDelを取り除
く。 

• With frequency below：指定した
頻度以下のものについてのみフィ
ルターを適用。 
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Fixed Ploidy Variant Detection 
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• Create track: トラックの作成 
• Create annotated table: アノテーション付

のテーブルの作成 
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Fixed Ploidy Variant Detection：ビューの見方 

114 



Sample to Insight 

Fixed Ploidy Variant Detection：結果 
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• Count: クオリティのフィルターをパスしたリードの数 
• Coverage: クオリティのフィルターをパスしたリードの数 
• Frequency: バリアントが見られた頻度 
• Probability: バリアントのアレルの事後確率（そのアレルが尤もであるとする

確率。高い方がより確度が高いという事。） 
• Forward reads: その領域に見られたForwardリードの数 
• Reverse reads:その領域に見られたReverseリードの数  
• Forward/reverse: Forward/Total reads または Reverse/Total reads のうち

小さい方の値。ForwardとReverseが同じなら、0.5となる。 
• Average quality: 該当する領域の平均リードクオリティ。  
• # unique start positions:バリアントコールに使われたリードのうちスタートポ

ジションにあるリードの数 
• # unique end positions:バリアントコールに使われたリードのうち最後の箇所

にあるリードの数 
• BaseQRankSum:クオリティスコアについて、参照配列と同じアレルとバア

リアントのアレルについてマンホイットニーU検定を行い計算されたZスコ
ア。これが高いほど参照配列の塩基とバリアントの塩基に差がある。 

• Hyper-alleic：想定されるアレルよりも頻度が高いかどうか 
• Homopolymer：ホモポリマー領域かどうか 
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Low Frequency Variant Detection 
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• Low frequency Variant Detection では、倍数性を仮定せず、

対象となる領域が、シーケンスエラーなのか、そうではない
（=バリアント）なのかを検定しています。 
 

• Error モデルについては、Fixed Ploidy Variant Detection にて

採用したエラーモデルを使い、計算し、尤度比検定を行って
います。 
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Low Frequency Variant Detection 
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• Navigation Areaからマッピングデータを選択。 
• Toolboxから Resequencing Analysis > Variant Detectors > Low 

Frequency  Variant Detection を選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 



Sample to Insight 

Low Frequency Variant Detection 
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• Required significance :シーケンスエラーか
どうか、検定の際の閾値 
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Low Frequency Variant Detection 
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Reference masking 
• Ignore positions with coverage above：

カバレッジが指定した数字以上のバリ
アントについてリストに含めない 

• Restrict calling to target regions：バリ
アントを検出したい領域の指定（アノ
テーショントラックで指定） 
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Low Frequency Variant Detection 
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Read filters 
• Ignore broken pairs：ペアエンドのリー

ドでペアと認識されなかったリードを
バリアント検出の計算に含めるかどう
か 

• Ignore non-specific matches：
「Reads」を選択すると、non-specific
なマッチのリードを計算に含めなくな
り、「Regions」を選択すると、1本で
もnon-specificなリードが含まれる場
合、その領域のバリアントを検出しま
せん。 

• Minimum read length：Ignore broken 
pairとIgnore non-specific regions が指
定された場合、このフィルターの対象
となる最小のリードの長さの設定が必
要です。これは非常に短いリードは、
その短さからnon-specificになる可能性
があるためです。 
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Low Frequency Variant Detection 
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Coverage and count filters 
Minimum coverage：最小カバレッジ 
Minimum count：バリアントを支持する
リードの最低カウント数 
Minimum frequency (%)：最小頻度 
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Low Frequency Variant Detection 
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Quality filter 
• Base quality filter:塩基のクオリティに

関するフィルター 
• Neighborhood radius：クオリティ

フィルターの対象とする横方向の
塩基数（奇数） 

• Minimum central quality：縦方向の
数（リード数） 

• Minimum neighborhood quality：
Neighborhood radiusで指定した範
囲の最低クオリティ（Phred 
score） 
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Low Frequency Variant Detection 
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Direction and position filters： 
• Read direction filter：どちらか一方の方向の

リードが多数見られる場合にそれを排除（た
だし、アンプリコンには適していません）。 

• Relative read direction filter：リードの
方向が一方のみに偏りすぎていないか、
全体のForwardとReverseのバランスを
見て統計検定を行う。Significanceで閾
値を入力。 

• Read position filter：システマティック
なエラーを取り除くために用いるツー
ルでハイブリダイゼーションを行った
場合のデータに有効。リードを5つのセ
グメントに分割し、バリアントの見ら
れるポジションの５つのセグメントに
分割されたリードの分布が全体のそれ
と似ているかどうか検定を行う。
Significanceで閾値を入力。 
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Low Frequency Variant Detection 
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Technology specific filters 
• Remove pyro-error variants：ホモポリ

マー領域に対するエラーの除去 
• In homopolymer regions with 

minimum length：指定した長さの
ホモポリマー領域のInDelを取り除
く。 

• With frequency below：指定した
頻度以下のものについてのみフィ
ルターを適用。 
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Low Frequency Variant Detection 
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• Create track: トラックの作成 
• Create annotated table: アノテーション付の

テーブルの作成 
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Low Frequency Variant Detection：結果 
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• Count: クオリティのフィルターをパスしたリードの数 
• Coverage: クオリティのフィルターをパスしたリードの数 
• Frequency: バリアントが見られた頻度 
• Probability: バリアントのアレルの事後確率（そのアレルが尤もであるとする

確率。高い方がより確度が高いという事。） 
• Forward reads: その領域に見られたForwardリードの数 
• Reverse reads:その領域に見られたReverseリードの数  
• Forward/reverse: Forward/Total reads または Reverse/Total reads のうち

小さい方の値。ForwardとReverseが同じなら、0.5となる。 
• Average quality: 該当する領域の平均リードクオリティ。  
• # unique start positions:バリアントコールに使われたリードのうちスタートポ

ジションにあるリードの数 
• # unique end positions:バリアントコールに使われたリードのうち最後の箇所

にあるリードの数 
• BaseQRankSum:クオリティスコアについて、参照配列と同じアレルとバア

リアントのアレルについてマンホイットニーU検定を行い計算されたZスコア。
これが高いほど参照配列の塩基とバリアントの塩基に差がある。 

• Hyper-alleic：想定されるアレルよりも頻度が高いかどうか 
• Homopolymer：ホモポリマー領域かどうか 
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挿入、欠失と構造変異解析 



Sample to Insight 

InDels and Structural Variants 
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• Quality Based Variant Detection やProbabilistic Variant Detection では変異やInDelを検出で
きました。 

• しかしながら大きなInDelの検出や構造変異については、上記ツールでの検出は難しい場合
があります。 
 

 
• アルゴリズムにとっては、大きなInsertionやDeletionを受け入れるよりは、Unaligned end

とするほうがスコアを大きくできるからです。 
• InDel and Structural Variants ツールでは、このUnaligned end に着目して、大きなInDelや

構造変異を見つけます。 
• Unaligned end が別の領域に十分な量マップすることができれば、そこまでの距離の

InsertionやDeletion、構造変異と考えられます。 
• 注意：このツールでは、同一染色体内の構造変異のみが検出可能です。 

 

 
 

 

＜ 
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InDels and Structural Variants 
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• Navigation Areaからマップするデータを選択。 
• Toolboxから InDels and Structural Variantsを選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 
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InDels and Structural Variants 
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• P-value threshold: 得られた coverage 数にお
いて、生じたunaligned end の数が得られる
確率がこの p-valueより少ない場合、break 
point を生成する。  

• Maximum number of mismatches: align され
た部分の mismatch がこの数以下のもののみ
カウントする。 

• Filter variants: ここで指定した数より少ない
リードにしかサポートされていない break 
point は除く。 
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InDels and Structural Variants 
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• Output について設定する。 
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InDels and Structural Variants 
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リシーケンシング解析：その他の機能 
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• Annotate from Known Variants : known 
variants とオーバーラップする variants にア
ノテーション付けする 

• Filter against Known variants : known 
variants と比較してフィルタリングする 

• Annotate with Exon Numbers : exon の番号
をアノテーションに追加する 

• Annotate with Flanking Sequences : 
reference の隣接する塩基とともにアノテー
ション付けする 

• Filter Marginal Variant Calls : Variant 
frequency, Forward/reverse balance,  
Average base quality などの条件でフィルタ
リングする 

• Filter Reference Variants : reference allele 
variants をフィルタリングする 
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リシーケンシング解析：その他の機能 
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• Compare Sample Variant Tracks: 2つの
variant track を比較して、共通する、また
は、異なる variant を出力する (Ver6.5で追
加)。 

• Compare Variants within Group : グループの
中で common variants を検索する。
Frequency を % で指定できる。 

• Fisher Exact Test : Case-control study で、
case に有意に存在する variants を検出す
る。 

• Trio Analysis : 子供と両親のデータを用いて 
trio 解析を行う。Variants が親に由来するの
か、de novo なのかをレポートする。 

• Filter against Control Reads : Control に存在
する variant をフィルタリングする。 
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リシーケンシング解析：その他の機能 
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• GO Enrichment Analysis : 検出された variants 
が含まれる遺伝子にどのような Gene Ontology 
と関連するものが多いのかを解析する。  

• Amino Acid Changes : variants に、アミノ酸置
換に関するアノテーション付けを行う。 

• Annotate with Conservation Score : 異なる種に
おけるアミノ酸の保存の程度に関する情報をア
ノテーション付けする。保存の度合いが高いほ
ど、機能的に重要であると期待される。 

• Predict Splice Site Effect : variants の splice 
site に対する影響を予測する。 
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アミノ酸置換の解析 



Sample to Insight 

アミノ酸置換の解析 
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• Resequencing Analysis – Amino Acid Changes を選択 
• Variant データを選択 
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アミノ酸置換の解析 

138 

• CDS の track を選択 

• ゲノム配列のtrackを選択 

• Filter synonymous: アミノ酸が変化す
る variant のみをアノテーション付け
するときにチェックする 

• Filter CDS regions with no variants: 
variantが無い領域をフィルターする 

• Genetic code: 解析しているゲノムで
該当するものを選択する 

• mRNAのtrackを選択 
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アミノ酸置換の解析 
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Variant Track 
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アミノ酸置換の解析 
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• アミノ酸置換に関する情報がテーブルに追加されました 
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アミノ酸置換の解析 
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Amino Acid Track 
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変異のフィルタリング  



Sample to Insight 

既知の variants の filter：Filter against Known Variants 
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• Navigation Areaから変異トラック(アミノ酸置換を調べたもの)を選択。 
• Toolboxから Resequencing Analysis > Annotate and Filter Variants > Filter 

against Known Variants を選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 
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既知の variants の filter：Filter against Known Variants 
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• SNPのトラックを選択。 • Known variants track:比較したい変異トラックを選択。 
• Auto join: 隣り合わせの変異について、フィルターをかける

際に一つの変異として扱うかどうか。 
• Filter Option 

Matchを残す：アレルまで完全に一致しているものを残す。 
Overlapを残す：オーバーラップがあるものを残す。 
Not matchを残す：完全に一致しなかったものを残す。 
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既知の variants の filter：Filter against Known Variants 
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既知の variants の filter：Filter against Known Variants 
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トラックで表示 

• dbSNP 

• 共通しなかったもの 
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遺伝子のアノテーション  
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アノテーション付け：Annotate with Overlap Information  
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• Navigation Areaから変異トラック(フィルタリングしたもの)を選択。 
• Toolboxから Track tools > Annotate and Filter > Annotate with Overlap 

Information を選択、ダブルクリック。 
• ウィザードが起動し、選択したデータが選ばれていることを確認。 
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アノテーション付け：Annotate with Overlap Information  
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• Gene の track を選択。 
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アノテーション付け：Annotate with Overlap Information  
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３D構造解析 
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3D構造解析：Link variants to 3D Protein Structure 
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Download 3D Protin Structure Database: 
Resequencing Analysis > Functional Consequencesの中
に含まれるこのツールでは、PDBに登録されているア
ミノ酸配列のデータベースをダウンロードします。この
後のLink Variant to 3D Protein Structure で必要となりま
す。 

 

 

 

 

Link Variants to 3D Protein Structure: 
ダウンロードしたアミノ酸配列に対して、変異の検出か
らアミノ酸置換させた配列を使いBLAST検索をかけま
す。 
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3D構造解析：Link variants to 3D Protein Structure 

153 
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3D構造解析：Link variants to 3D Protein Structure 

154 
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お疲れ様でした。 
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